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ǘŀō ά9ƴŎƭƻǎǳǊŜ aƻƴƛǘƻǊƛƴƎέ 

 10/2022 JAFZ New control module for reduced mobility parking 
spaces. 

 12/2022 IDP bŜǿ ŎƻƴǘǊƻƭ ά5ŀǎƘōƻŀǊŘέ 

    

    

    

    

 



Plugin ς Extended LPR - Installation and User Manual 

 

 

 4 

2. Introduction 
 

The purpose of this document is to explain the installation, operation and use of the 

Milestone plugin LPR Extended. 

This plugin, making use of the license plate readings made by the Milestone LPR Add-

on, and therefore without the need to add an additional third-party license plate reading 

system/server, adds new advanced features related to LPR: 

V Vehicle gauge control. 

V Exceeded stay time alerts. 

V Lists with temporary license plates. 

V Automatic daily LPR reports. 

V Control access for shared spaces in car parks. 

V Reduced mobility parking space control events 

The plugin enables the possibility to define virtual enclosures based on entrance and 

exit cameras, monitoring their occupation from Smart Client and receiving occupation related 

events in Milestone. Inside these enclosures, subareas of shared spaces can be defined for a 

license plate list, so that access to those shared spaces is controlled.  

Email notifications can also be sent when a vehicle leaving an enclosure has exceeded 

the stay time established for that enclosure. 

Additionally, the plugin enables the possibility to have temporary records in the 

Milestone license plates lists, allowing the operator to add a license plate to a list with an 

expiration date, and automatically deleting the license plate when the entered date has passed.  

The plugin allows the registration of HikVision decoders with parking space control for 

fast parking space management and event generation in Milestone. 

Finally, the plugin can automatically generate a daily CSV report with all the license 

plates that the system has read. 

This way, we can have an informative tool on the vehicle occupation of a certain 

enclosure, a control on the vehicles that stay inside that enclosure longer than allowed, valid 

license plates with expiration date, control of the occupancy of parking spaces for people with 

reduced mobility and daily reports of the license plates read by our Milestone LPR.  
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3. Architecture 
 

The system is made up of several parts:  

¶ Milestone license plate readings. 

¶ Enclosure management. 

¶ Subareas management. 

¶ Exceeded stay time alerts and reports.  

¶ Temporary license plate lists.  

¶ Daily LPR reports. 

¶ Management of parking space decoders 

 

Milestone license plate readings 
The LPR Extended plugin does not read license plates but feeds on the information that 

Milestone provides through its automatic license plate recognition module (LPR Add-on). 

Therefore, everything related to license plate reading, configuration, parameterization, 
etc., depends on the Milestone LPR module and must be dealt with from its own 
configuration. For more information, see the Milestone manual. 

Through the management of enclosures, each camera may be assigned to the entrance 
or exit of an enclosure. The same camera may be interpreted as an exit from one enclosure and 
an entrance to another, but a single camera can never be configured as the entrance and the 
exit of the same enclosure, and must not read the license plates of cars both coming in and going 
out of the enclosure. 

Enclosures management 
The plugin allows to define and manage enclosures. Each enclosure is defined by the 

following properties:  
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¶ Enclosure name. 

¶ Maximum capacity. 

¶ Pre-alarm threshold (percentage). 

¶ The list of cameras that are entrances to the enclosure. 

¶ The list of cameras that are exits from the enclosure. 

¶ Maximum stay time allowed.  

Subareas management 
The plugin lets you define subareas inside enclosures. These subareas are defined by a 

set of shared parking spaces and a license plate lists. The aim of these subareas is to be able to 

reserve some spaces for a group of people. If the shared spaces are less than the people that 

can use them, then the first come first served principle applies.  

So, if the shared subarea is already full when an allowed license plate is read by the 

entrance camera, the access will be rejected, and an event will be triggered in Milestone.  

If there is still any free space, then the access will be granted, and again an event will be 

triggered in Milestone to inform so.  

! ǎǳōŀǊŜŀ ƛǎ ōƻǳƴŘ ǘƻ ǘƘŜ ŜƴŎƭƻǎǳǊŜ ǿƘŜǊŜ ƛǘΩǎ ƭƻŎŀǘŜŘΣ ŀƴŘ Ƙŀǎ ǎƻƳŜ ƻǘƘŜǊ ǇǊƻǇŜǊǘƛŜǎΥ 

¶ Name of the subarea. 

¶ Number of shared spaces. 

¶ The list of license plates assigned to the subarea.  

Exceeded stay time alerts and reports 
When a vehicle leaves an enclosure, the time that it has remained in the enclosure will 

be calculated, checking the time that the same vehicle entered the enclosure. To do so, the 

plugin searches the last time that any of the entrance cameras has registered the same license 

plate that has just been read by the exit camera.  

If the stay time is longer than the configured one, then a Milestone event will be raised 

and a report with the images of the entrance and exit moments will be sent by email. 

 It is necessary to bear in mind that LPR systems, despite their great efficiency, are not 

infallible and depend largely on multiple factors, such as environmental factors, the installation 

of the camera or the configuration of the license plate recognition tool, therefore that abnormal 

situations could arise. For example, a vehicle could enter an enclosure and the entrance camera 

may not read its license plate, or it may read it wrongly (for example, license plate 1234JBH 

might be read as 1234JBM). In this case, when the exit camera will read it, the plugin will not be 

able to correctly calculate the stay time since, either there is no entry reading, or the last entry 

reading is from another day, reporting a stay time greater than real. 

It is the customer's responsibility to verify the information generated by the system in 

cases of anomaly. 

Temporary license plates lists 
Using the custom fields of Milestone lists, we can set one of the fields as the due date 

of the register and tell the plugin which lists have temporary license plates and which field 

contains the due date. The date format must be: 
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DD/MM/YYYY 

The plugin will periodically check the selected lists and automatically delete the records 

where the value of the field containing the due date is before the current day. 

This feature is very useful to create temporary white lists, where we can grant access to 

some license plates until a certain date. 

Daily LPR reports 
We can configure the plugin to send daily reports with the Milestone LPR readings in 

CSV format. We can select what time the report will be generated and automatically sent by 

email, according to configuration. 

Management of parking space decoders 
We can add several HikVision decoders, from which we can obtain information about 

the parking spaces configured and generate Milestone events. 
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4. Installation 
 

To install the plugin, simply run with administrator permissions the "SGSE Extended LPR 

Plugin Installer.msi" installer provided by SGSE. The process is automatic. Through the different 

screens of the installer, we will only have to accept the End User License Agreement, a necessary 

condition to be able to use the plugin. 

 

Click "Next>" to begin the installation process. 
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Please read and accept the End User License Agreement to install the plugin. 

 

Click "Next>" to continue and install the plugin files. 
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If Windows User Account Control is enabled, allow the installer to continue with the 

installation.  

 

  

Once the process is finished, you can click " Close ". The plugin is already installed. 

  



Plugin ς Extended LPR - Installation and User Manual 

 

 

 11 

¢ƻ ƛƴǎǘŀƭƭ ǘƘŜ ŘŀǎƘōƻŀǊŘΣ Ǌǳƴ ǘƘŜ άSGSE ExtendedLPR Dashboard Installer.msiέ ƛƴǎǘŀƭƭŜǊ 

in the same way. 

 

Click "Next>" to begin the installation process. 
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Please read and accept the End User License Agreement to install the plugin. 

 

Click "Next>" to continue and install the plugin files. 
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If Windows User Account Control is enabled, allow the installer to continue with the 

installation.  

 

 

Once the process is finished, you can click " Close ". The plugin is already installed. 
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Additional configuration 
In case the dashboard service is not going to be installed on the same machine where 

the Event Server is installed, the full URL of the dashboard web service must be specified. This 

can be done both in the Smart Client and in the Management Client in the following options: 

Smart Client: 

Settings > Extended LPR Dashboard 
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Management Client: 

Tools > Options > Extended LPR Dashboard 

 

The value is common and can be specified in either of these two views. By default, if the 

value is empty, it will be assumed that the dashboard is installed on the same machine as the 

Event Server. 

If you want to establish a specific configuration on a specific machine, you can modify 

the file C:\Program Files\Milestone\MIPPlugins\ExtendedLPR\LPRExtended.dll.config by filling in 

the dashboardUrl property with the full URL of the dashboard web service. 

<add  key ="dashboardUrl"  value ="http://servidor/ ExtendedLPRDashboard " />  

This value will take precedence over the settings specified in the previous panel. 

The dashboard service has a variable to specify the connection to the SQL Server 

database. By default it will try to make a connection against the local machine but it can be 

customized in the file C:\Program Files\SGSE\SGSE LPR Extended Dashboard\appsettings.json 
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5. Licensing 
 

The plugin needs a license to run. For each pair of cameras used to define enclosures it 

will be necessary to purchase a license. Please consult the licensing model with SGSE.  

These licenses are generated by SGSE. The procedure to obtain the license file 

corresponding to the purchased license is described below. 

A. Get the UID 
To have your license file generated, you will have to provide SGSE the corresponding 

UID. This UID is a unique identifier to which the license is bound.  

To get this code, run XProtect® Management Client after installing the plugin and 

navigate to the plugin option in the left side tree menu (MIP Plugins > Extended LPR). 

This screen will show the corresponding UID when the plugin is not licensed.  

 

Please provide this UID to SGSE so they can generate your license.  

B. Applying the license 
/ƻǇȅ ǘƘŜ ƭƛŎŜƴǎŜ ŦƛƭŜ άLicencia.licέ ƛƴ ǘƘŜ ǇƭǳƎƛƴ ŘƛǊŜŎǘƻǊȅΦ .ȅ ŘŜŦŀǳƭǘΥ 

C: \ Program Files \ Milestone \ MIPPlugins \ Extended LPR\  

Once the license is applied, it is necessary to restart the Event Server for the changes to 

take effect and you can user the plugin. 
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The Management Client interface will show the license information: 

 

The Event Server machine must be licensed. 

C. Client workstations (only Smart Client or Management Client) 
Every client machine (Management Client or Smart Client) must also have a Licencia.lic 

file. These are free of charge but required to operate. Please contact SGSE with the UID for the 

ƳŀŎƘƛƴŜΣ ǎǇŜŎƛŦȅƛƴƎ ǘƘŀǘ ƛǘΩǎ ŀ ŎƭƛŜƴǘ ¦L5 ŀƴŘ ŀ ǿŀȅ ǘƻ ƛŘŜƴǘƛŦȅ ǘƘŜ t/ ƛǘ ŎƻǊǊŜǎǇƻƴŘǎ ǘƻΦ {D{9 ǿƛƭƭ 

get back to you with the corresponding Licencia.lic with the identification you provide.  

To obtain the UID on a machine where the XProtect ® Management Client configuration 

application is not installed and only the Smart Client is available, it will be necessary to use the 

{D{9 άUID Generatorέ ǘƻƻƭΦ 

Contact SGSE technical support to obtain this tool. 
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6. Configuration 
 

The solution is based on several elements, interrelated but independent. For the correct 

global operation of the solution, each of them requires to be configured: 

¶ Milestone license plate reading (LPR add-on). 

¶ Enclosures management. 

¶ Subareas management*. 

¶ Exceeded stay time alerts and reports. 

¶ Temporary license plates lists* . 

¶ Daily LPR reports. 

¶ Management of parking space decoders. 

Features marked with an * should be performed from the Management Client in the 

Event Server (actually, in the Server where the SQL Server is installed). Otherwise, additional 

configuration is required for them to work. 

Milestone license plate reading (LPR add-on) 
The license plate reading module is essential. This module obtains the information that 

the solution associates to entrances and exits, and without this information is not possible to 

carry out the occupancy control nor calculate stay time. 

For this reason, it is necessary to install and configure this module following the 

indications given by Milestone to optimize the license plate detection and reading process.  

Please, refer to the Milestone manual to set up the license plate reading system.  

Enclosures management 
The plugin allows you to manage enclosures. Each enclosure requires a name to be 

identified in the system, and a series of configuration parameters, that can be set from the 

Management Client: 

¶ Maximum capacity 

¶ Pre-alarm threshold 

¶ Maximum stay time 

¶ List of cameras that are entrances to the enclosure 

¶ List of cameras that are exits from the enclosure 
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Parameters and their meaning are explained in the table below: 

Parameter Description 

Max. Gauge It is the maximum number of vehicles allowed inside the 
enclosure. When this value is reached, an event is triggered in 
Milestone: Max occupation reached. 

Alert threshold (%) It sets the occupancy pŜǊŎŜƴǘŀƎŜ ǘƘŀǘ ƛǎ ŎƻƴǎƛŘŜǊŜŘ άƘƛƎƘ 
ƻŎŎǳǇŀƴŎȅέ ŀƴŘ ŎƭƻǎŜ ǘƻ ǘƘŜ ƳŀȄƛƳǳƳ capacity. When this 
threshold is overcome, an evento is triggered in Milestone: Alert 
threshold reached.  

Max. Stay time allowed: Maximum time to be spent inside the enclosure. If a time higher 
than 0, the time that vehicles stay inside the enclosure will be 
calculated when they leave it, and a notification will be sent if it 
exceeds this parameter (see reports configuration). 

Incoming cameras List of cameras that represent entrances to the enclosure. When 
a camera on this list reads a license plate the occupancy of the 
enclosure is increased by one.  

Outgoing cameras List of cameras that represent exits from the enclosure. When a 
camera on this list reads a license plate the occupancy of the 
enclosure is decreased by one.  
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Subareas management 
Subareas can be created inside an enclosure. To define them, a name is required to 

identify it in the system, and some other parameters: 

¶ The number of shared spaces that there are in the subarea. 

¶ The list of license plates that share these spaces.  

 

Should it be needed to specify manually the current occupancy of a subarea (because 

ǘƘŜ [tw  ŘƛŘƴΩǘ ǊŜŀŘ ǇǊƻǇŜǊƭȅ ŀ ƭƛŎŜƴǎŜ ǇƭŀǘŜ ƎƻƛƴƎ ƻǳǘ ƻŦ ǘƘŜ ǇŀǊƪƛƴƎΣ ƻǊ ōŜŎŀǳǎŜ ǿƘŜƴ ǘƘŜ ǇƭǳƎƛƴ 

is installed there are already cars in shared spaces), usiƴƎ ǘƘŜ ōǳǘǘƻƴ ά{Ŝǘ ŎǳǊǊŜƴǘ ƻŎŎǳǇŀƴŎȅέ 

you can specify the number of shared spaces that are already occupied in the subarea.  

 

Exceeded stay time alerts and reports 
When a vehicle exceeds the residence time of an enclosure, the plugin can send a PDF 

report with the images by email, using the SMTP protocol. To do this, it is necessary to have a 

mail server with SMTP support and configure the parameters for sending LPR reports 
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In the Management Client, go to Tools > Options > LPR Reports. 

There you will find two tabs, one to configure the email server, and another one to 

customize email. 

 Lƴ ǘƘŜ ŦƛǊǎǘ ǘŀōΣ άReport settingsέΣ ȅƻǳ Ŏŀƴ ŎƻƴŦƛƎǳǊŜΥ 

¶ The address of the mail server to send emails using SMTP. 

¶ The SMTP port of the mail server.  

¶ The account (user and password) that will be used to authenticate in the mail server 

to send emails. 

¶ If the server uses SSL or not.  

 

The plugin will send emails making use of the configured mail server.  

Lƴ ǘƘŜ ƴŜȄǘ ǘŀōΣ άaŀƛƭ ŎƻƳǇƻǎƛǘƛƻƴέΣ ȅƻǳ Ŏŀƴ ŘŜŦƛƴŜΥ 

¶ The recipients of the email (to, CC, and BCC) 

¶ The subject of the email. 

¶ The body of the email. 
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Temporary license plates lists 
To configure temporary lists, the first thing needed is a license plates list. Each list 

containing temporary license plates must define one of the 5 available custom fields to hold the 

expiration date of the license plate.  

¢ƻ Řƻ ǎƻΣ ǎŜƭŜŎǘ ǘƘŜ ƭƛǎǘ ŀƴŘ ŎƭƛŎƪ ά/ǳǎǘƻƳ ŦƛŜƭŘǎΧέΦ In the configuration window, define 

the fields and use one to contain the validity date. Take note of the name of that field, as you 

will need it later on.  
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Once the list contains a field to hold the validity date of the record, when you register 

new license plates you will have to fill that field with the date until which the license plate will 

be kept in the list. The date format must be:  

DD/MM/YYYY 

 

The next step is to tell the plugin which lists contain temporary license plates and which 

field contains the due date.  

Go to the oǇǘƛƻƴ άTemporary listsέΣ ǎŜƭŜŎǘ ǘƘŜ ƭƛǎǘǎ ǘƘŀǘ Ŏƻƴǘŀƛƴ ǘŜƳǇƻǊŀǊȅ ƭƛŎŜƴǎŜ ǇƭŀǘŜǎ 

and write the name of the field that contains the date.  

 

Saving changes starts a process that will periodically check the selected lists, and 

automatically remove the records which due date is previous to the current day.  

Automatic daily LPR reports 
To send daily reports of LPR readings it is necessary to configure the parameters of the 

mail server and the recipients of the email containing the report (see Exceeded stay time alerts 

and reports). 
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In addition, we can configure the time at which we want the process to start every day, 

and if the data included in the report are from the current day (until the time the process starts) 

or from the previous day.  

 

You can select if you want the report to be generated and sent, by checking or 

ǳƴŎƘŜŎƪƛƴƎ ǘƘŜ ŎƘŜŎƪōƻȄ άEnable daily reportsέΦ 

Management of parking space decoders 
To be able to work with the decoders, they must first be created within the plugin 

configuration, in the section LPR Extended -> Decoders -> Add New. 

After adding a decoder, it is necessary to add its configuration: User, password and IP 

address of the decoder. 

It is necessary to save the configuration for it to take effect. Once configured, we will be 

able to collect events in our Milestone Smart Client. 

Events 
The plugin adds nŜǿ ŜǾŜƴǘǎ ǘƻ aƛƭŜǎǘƻƴŜΣ ǳƴŘŜǊ ǘƘŜ ƎǊƻǳǇ ά[tw DŀǳƎŜ 9ǾŜƴǘǎέΣ ǘƘŀǘ Ŏŀƴ 

be used to define both rules and alarms in Milestone: 
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¶ Max occupation reached. 

¶ Max occupation restored. 

¶ Max staty time exceeded. 

¶ Max staty time exceded without exit. 

¶ Alert threshold reached.  

¶ Alert threshold restored. 

 

  

Events related to alert threshold, maximum occupation and exceeded stay time are related only 

to enclosures, not to subareas. 

Access granted and access denied events instead are related to subareas, not to enclosures. 

Access control is only performed when the license plate read by the entrance cameras is part of 

a list that is related to a subareas. Otherwise, no event of this kind is triggered.  

Aim and example 
The aim of enclosures is to monitor the gauge, not to control access. That can still be performed 

with lists not associated to subareas and standard milestone LPR events.  

The aim of subareas, as described above in this manual, is to share a number of parking spaces 

between several cars. For example, you could reserve 3 parking spaces for the administration 

department, where 5 people work. They would have access, but if there are already 3 cars inside 

(that is, all the shared spaces are full), then the access is denied.  

You can define full access control if all the spaces of a parking are assigned to a subarea and the 

άUnlisted license plateέ ǎǘŀƴŘŀǊŘ aƛƭŜǎǘƻƴŜ ŜǾŜƴǘ ŘƻŜǎ ƴƻǘ ƻǇŜƴ ǘƘŜ ƎŀǘŜΣ ǎƻ ǘƘŀǘ ƛǘ ƻƴƭȅ ƻǇŜƴǎ 

when an authorized license plate gets to the entrance camera and its assigned subarea still has 

free spaces.  
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7. Operation 
 

The plugin operates automatically once you have configured it. The operator will be able 

to monitor the status of enclosures from the Smart Client, thanks to the module the plugin 

includes.  

Visualization in Smart Client 
To see the status of an enclosure, you just have to simply drag the component 

ά9ƴŎƭƻǎǳǊŜ ƎŀǳƎŜέ ŀƴŘ ŘǊƻǇ ƛǘ ƛƴǘƻ ŀ ǘƛƭŜ ƻŦ ǘƘŜ {ƳŀǊǘ /ƭƛŜƴǘ ǾƛŜǿΦ  

 

The status of the enclosure is shown thorugh the next interface: 

 

When the control is in the tile, you must specify which enclosure this control will show 

the information from. To do so, select the user control and in the left side bar select the desired 

enclosure: 



Plugin ς Extended LPR - Installation and User Manual 

 

 

 27 

 

This way, you can view quickly the occupancy of an enclosure while watching maps, 

cameras, alarmǎΣ ŜǘŎΧ 

 

 

Enclosures status modification  
If the Smart Client user has the permissions to edit settings, they can change the 

enclosure settings from the Smart Client interface.  

From this interface, you can: 

¶ Modify the maximum capacity of the enclosure. 

¶ Modify the alert threshold. 

¶ Update manually the current occupancy of the enclosure. 




















